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1.0 Introduction

SeaDisplaySetup application is used to produce geographical site maps for use in
SeaDisplay, RadialDisplay, and RadialEditor applications.

Here is a list of the application features:

>
>
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Any coastline of in the world can be plotted on a site map

The coastline can be shifted, expanded, contracted, etc. with the combinations of
the arrow keys

SeaSonde coverage areas of two or more sites can be displayed

The location of the mouse pointer in terms of latitude and longitude can be
displayed continuously

The distance in Km between any two points can be displayed by click and drag
Up to 64 SeaSonde sites can be placed on the coastline map

Up to 128 markers of various shapes can be placed on the map

Positions of SeaSonde sites, markers and all other map annotations supplied
with the modeless dialog boxes can be entered by double clicking the mouse
Maps and associated site data are saved in the resource file format that is
required by the applications SeaDisplay and RadialDisplay

Maps and associated site data may also be saved in a text file with Jpeg file
format for transport to non-Macintosh systems

The Lambert Conformal Conic mapping projection is required to insure
compatibility with the applications SeaDisplay and RadialDisplay, but you may
choose a variety of other projections

Vector grids and all associated grid files required by the application SeaDisplay
may be created

Grid points that lie over land can be automatically deleted

This manual will describe the functions and features of the application
SeaDisplaySetup. The basic menu features will be discussed, followed by a section
dedicated specifically to describing the features within the Map menu. In addition, there
will be sections focused on creating a site map as well as creating a vector grid.



2.0 Important Menu Features

There are three main drop-down menus in SeaDisplaySetup, the File menu, the Options
menu, and the Map menu (all of which are shown in figures below).

outlined below, with detailed descriptions of various important features within each

menu.

2.1 File Menu

The File menu items with their associated actions are listed below; more detailed
explanations of various features are discussed in related sections.

JIZW Edit  Options
New... 6N
Open... &0
Close W
Save 3£ 5
Save as...

Save as JPEG. ..
Save as PICT...

New...

Open...

Close

Save

Save as...

Save as JPEG...

Save as PICT...

Page Setup...

Print...

Print now

Creates a new map (default is
San Francisco Bay)

Opens a previously created
SD Site file

Close the active map window

Save the active map in
SeaDisplay format

Change file name and save
for SeaDisplay or
RadialDisplay

Saves the active map image
in a JPEG format

Saves the active map only in
PICT file format

Brings up standard printer
page setup

Brings up standard print
window

Print without printer dialog
box

Each menu is



2.2 Options Menu

Change Loc. format
Show Location
Show Km and Bearing

v Identify land
Slow draw
Swap colors

Memary...

2.3 Options Menu: Detailed
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Change location format

Show location

Show Km and Bearing

Changes the format
of the
latitude/longitude
display

Displays latitude and
longitude of the
mouse pointer

By checking this
feature when Show
location is checked,
the display will
include bearing
angle and distance
in km.

This brief section will highlight the few features under the Options menu that

require more detailed information such as:

Open...

Save as...

Save as JPEG...
Save as PICT...

YV V VYV V

Open...

The application can open a file in either the SeaDisplay Site XXXX format or the
SDSite_ XXXX text format. The application cannot open files in the PICT format
because area and site parameters are not included in this file format. The open dialog
lists only those files that are types TEXT or Site.

Save as...

Maps and associated site parameters (also known as site definition files or site map
files) may be saved with any file name you desire. However, to be properly recognized
by the application SeaDisplay or RadialDisplay, the maps saved via Save and Save
as... under the File menu must have names of the form SeaDisplay Site XXXX or
SeaDisplay_Site XXXX, where XXXX is the 4 character designation for your SeaSonde

site.

Save as JPEG...



When you save files in the JPEG format, the application gives the file a name in the
form SDSite_ XXXX in order to distinguish this file format from the format discussed
above. You can also select among various resolutions: normal, 150 pixels per inch, 300

ppi and 600 ppi.

Save as PICT...

When you save the map as a PICT file, the application cannot open that file because
the site parameters are not saved with the file.

2.4 Map Menu

Sites. ..
Area...
Title. ..

Km legend...
Cm/s legend...
Logo...

N/S arrow...
Lat/Lon grid...
Colors...
Date/Time...
Vector grid...

Coverage display...

Markers. ..

36 1
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360
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Sites...

Area...

Title...

Data base

Km legend
Cm/s legend
Logo...

N/S arrow...

Lat/Lon grid...

Colors...

Date/Time...

Vector grid...

Coverage display...

Markers...

Define the SeaSonde sites

Define the map area
boundries

Define the map title

Disabled. See detail of
Area for data base selection

Define the km legend
Define the cm/s legend
Locate the company logo

Locate the North/South map
arrow

Define the lat/lon map grid

Change the colors of land
and sea

Locate the date/time
annotation

Define the x-axis and vector
grid

Define the coverage area
display

Define various map markers



3.0 Map Menu: Detailed

The features of the Map menu are used to create SeaDisplay Site maps. Within the
Map menu, the SeaSonde sites are determined, as well as the area of the map
coverage area. In addition, map annotations such as the title, legend, N/S arrow,
colors, date/time, etc. are all listed under the Map drop-down menu.

This section will give details and descriptions of the functions within this menu. Refer to
the previous section for a layout of the Map menu.

3.1 Sites...

This dialog box allows you to create, edit, and draw up to 64 SeaSonde site locations on
your SeaDisplay Site map. However, only the first 6 sites will contribute to total vector
calculation. The Site Definition dialog box is shown below.

e 0 Site Definition(*)
Enter Site 2
Site# Mame HEAY
) Show ™ Lon, Lat ) Bearings
2 Longitude 122% 31" 19.0" W
; Latitude 37% 3140080 M
#sites Settings ( More.. )
3 —
& Warn Optional ( Grid... )
Reset | ( Add ) ( Delete ) { Draw | ([  OK

Site navigation

The current site number (Site#) that is being edited is shown on the left in the edit box
between the + and - buttons. You can click those buttons to change site selections or
entry the desired site number into the edit box. The total number of defined sites is
shown under the #sites notation. If this number is zero then no sites are currently
defined.

Use the Add and Delete buttons at the bottom to create and delete sites.



Once a site has been created you define its properties by filling in the Name,
Longitude and Latitude edit boxes. And you further define the site by using the More...
and Grid... buttons.

Use the Reset button to restore the current site definition to the state at the time the
dialog box was opened, i.e. to undo any changes you have made since opening the
Sites... dialog box.

Use the Draw button to ensure that your current settings are displayed on the map.

Note: When you delete a site, it's definition is moved to the end of the current list
of sites and the number in the list is reduced by one. When you add a site the
number of sites is increased by one and the last definition in the list is displayed.
This means you can rearrange the site order by clicking Delete and Add to move
the current site definition to the end of the list and reinstate it to active status.

Site definition

Click the Add button to create a new site and fill in the edit boxes to define its name and
location. The name must be exactly four characters in length. You can turn on the Show
location option and set the Show radio buttons to Lon,Latthen double-click on the map
at the location of the site to send the longitude and latitude to the dialog box. Use the
More... button to define more characteristics of the site and the Grid... button to fill in
values needed to define and display a radial grid for the site (see Site Settings: More
button section below).

Latitude and longitude entries can be specified as fractional degrees or degrees with
fractional minutes and it will be converted to degrees, minutes and seconds. You don't
have to type the degrees, minutes or seconds marks; you do have to type the W/E and
N/S letters at the end of the longitude and latitude.

Each site can have bearing limits imposed while drawing SeaSonde coverage displays
or while computing vector grid files. You must select Show Km and Bearing, Show
location, and the Draw bearing limits box in the More... dialog to display the bearing
limits on the map and change them as you enter new limits. To send the bearing angles
to the Sites... dialog, click on the site in the map window and drag in the direction of the
desired bearing angle. When you release the drag, the bearing angle will be sent to the
angle marked with (*).

Site Settings: More button
In addition to enabling/disabling the bearing limits display, this dialog box allows you to:

> Define the range of the site with the 'Max Km' edit box
> Specify range rings to be drawn (0 means don't draw range rings)
> Change the size and color of the SeaSonde symbol for the site



Site optional: Grid button

All of the information in the Grid... dialog box is used to create vector grids and grid
files. In addition, the information in items 7 and 2 are used when creating SeaSonde
coverage displays. The selections under item 3 will be disabled (grayed out) if the grid
options have not been enabled in the Vector grid... dialog box.

3.2 Area...

The Area dialog box allows you to define the coastal area that you wish to see on your

SeaDisplay site map.

e 0O Area Boundary(*)

Mapping boundary:
Morthwest corner f?" (*)

Latitude | 38° 28'37.0" I |
Longitude |124° 4 13.0"W |

Southeast corner () (%)

Latitude | 36° 40'58.6" N |
Longitude |121° 41' 33.6" W |

Use Site Info for Boundry

Mapping options:

N/5 degrees per inch: |0.1334
Projection = Lambert Con... T] '
Data Base | WVS250K.DAT |#] |
[ Maximize Window |
| Revert |
i Cancel ) [ Draw | | (8] |

[~ [=] =]

You can either insert the latitudes and
longitudes, or if you have entered site
information you can check the Use site
info for boundary box to see the
approximate coastal area. The program
will use the maximum range
information of the sites to determine
the size of the area to draw. From this
point you can use the <arrow> key
combinations to shrink, expand or
move the area around.

You can use the N/S degrees per inch
edit box if you want to change the map
size using this scale. If you check the
Maximum sized window box the map
will be expanded to the program's
definition of the maximum size that can
fit on your screen. Either way, the map
is not allowed to be bigger than this
size.

The Projection drop-down menu gives
you various choices of map projections
that can be used when drawing the
map. However, only the Lambert
Conformal Conic will draw a map
where distance in Km is linear in all
directions.

For this reason the application SeaDisplay assumes that the Lambert Conformal Conic

projection has been used to produce the map.



The Data Base drop-down menu lets you choose your coastline data base file. The
default data base file is WVS250K.DAT due to its efficiency. If you select one of the
closed polygon (GSHHS) files, the application will take some time to find and use the
closed polygons that define your coastline area. After the polygons have been
collected, and the map drawn, the notation ‘V3’ will appear in the bottom left corner of
the map to let you know that you are using the version 3 (closed polygon) coastline data
base.

3.3 Title...

The Title... dialog allows you to specify and place the map title anywhere on the map. In
this case the location of the mouse when it is double clicked is translated into a
percentage in the x and y directions of the screen. In order to use the double clicked
location you must select Custom (x,y) from the Placement drop-down menu.

3.4 Data base...

This item has been disabled because its functionality has been moved to the Area
dialog box. In order learn about changing the coastline data base, see section 3.2 Area.

3.5 Legends, Date/Time, Lat/Lon grid and Markers

Km legend...

The Km legend... dialog allows you to place and tailor the distance legend of the
coastline map. The Enable box must be checked if you want this legend drawn on the
map. If you double click the mouse to position this legend, the mouse location will be
translated into percent from left and percent from top of the map window. This means if
you zoom the coastal map in or out the relative location of the legend will stay the same.
It will not follow its original (longitude, latitude) position. However, the site locations
follow their (longitude, latitude) position when zooming in or out.

Cm/s legend

The Cm/s legend... dialog allows you to place and tailor the vector speed legend of the
coastline map. The Enabled box must be checked for this legend to be drawn on the
coastline map. However, it is not drawn on the saved maps because applications
SeaDisplay and RadialDisplay redraw the legend based upon your settings made here.
Application SeaDisplay must redraw the legend because it allows you to change the
units and with each unit change there must be an annotation of the new units.

Logo...
The Logo... dialog allows you place both the COS and your own (User) logo on the
coastline map. The double-click location will go to which ever logo has the (*) radio
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button checked. To enter your own (User) logo, copy your logo into a JPEG file named
ULogo.jpg and place the file in the same folder as application SeaDisplaySetup. Then
you will be able to position, scale and copy the logo in various modes.

N/S arrow

The N/S arrow... dialog allows you to place, color and size the North-South map
orientation arrow. Double-click locations are translated into percent from left and
percent from top screen locations. The Enabled box must be checked for the annotation
to be drawn on the map.

Date/Time

The Date/Time... dialog allows you to specify the location at which applications
SeaDisplay and RadialDisplay will draw the date and time of the files of current vectors
that it displays on the map. The Enabled box must be checked for a sample of the
date/time annotation to be drawn for you. The sample is not copied to saved maps.

Lat/Lon grid...

The Lat/Lon grid... dialog allows you to define the grid of latitude and longitudes lines
that are drawn on the map. The Enabled box must be checked for this annotation to be
drawn. Every other line is annotated. The radio buttons determine on which side of the
map the annotation will appear. You can double-click on the side of the map that you
desire and the annotation will be switched to that side.

Markers

Using the Markers... dialog you can place up to 128 markers of various shapes on the
map. The markers may be placed at a longitude and latitude location or they may be
placed relative to the map window - percent from the left and percent from the top of the
map. The Markers... dialog box is similar to the Sites... dialog box in content and
operation. Double clicks may be received as (longitude, latitude) or (% from left, %from
top). Set the Location radio buttons accordingly. You specify the characteristics of the
marker with the Mark... button that brings up a dialog box containing symbols to choose
from.

3.6 Colors...

The Colors... dialog box allows you to specify the colors for the sea, the land, the lakes,
etc. If you check the box Coastline, the coastline will be drawn in the same color as the
land instead of black as in the past. This removes the black coastline that sometimes
interferes with map annotations that pass over the coastline. This option is especially
helpful along coastlines that have many small islands or very jagged outlines.

The box Mac polygons for coloring land gives you the option of using the Macintosh
QuickDraw objects named 'polygons' to color in the land or the Macintosh QuickDraw
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objects named 'regions' to color in the land. The polygons tend to use less memory
space. This becomes an issue when you try to write a JPEG file at high resolution (300
or 600 dots per inch). The Mac OS has a memory size limit of 64KB for each of these
objects. If you exceed this limit while writing a JPEG file try switching to the polygons. If
that fails you will have to use a lower resolution, 150 dpi for example.

The box Use bit patterns for fill colors allows you to select between bit patterns for color

or the usual RGB (red, green, blue) color specification. This will become an issue only
on devices that have limited 'pixel depth' when drawing colors.

3.7 Vector grid...

The 'Vector grid..."' dialog allows you to enable/disable the vector grid feature of the
application and to define the x-axis of the vector grid, define the spacing and number of
grid points in the x and y directions and select among a number of grid display options.
The button Grid options... is enabled only when the Enable grid options check box is
checked. The Enable grid options' check box is handy when you are using the closed
polygon (V3) coastline data base and do not want to work with vector grids. If you leave
the box unchecked then the application will not attempt to compute nor display a radial
or total vector grid even though you may have all the parameters defined.

To define a total vector grid you should first define all of the radial grids using the Grid...
button in the Sites... dialog. Then you should use the three buttons in top-down order of
this dialog, i.e. start with the X-axis definition... button.

X-axis definition

For the new Combine software the x-axis is usually chosen to be a horizontal line on the
map. You can specify an x-axis for the new Combine software in three different ways
corresponding to the three radio buttons Specify two (lat,lon) points, Origin (lat,lon) and
bearing, and Default (East-North, centered).

For the original Combine software the x-axis of the total vector grid is usually chosen to
be a line joining two of the SeaSonde sites. There must be at least two SeaSonde sites
to compute total vectors. Use the Change... button to activate a dialog box that will let
you select the SeaSonde sites that are to be the end points of the x-axis.

Use the Show the x-axis and origin check box to draw the specified x-axis on the map.

Grid Definition...

The grid definition is similar to that in application SeaDisplay. You specify the grid
spacing in Km and the number of grid points in the x and y directions. The grid point at
the origin is numbered (0,0). Each x index identifies a column of grid points and each y
index identifies a row of grid points. The values minX and maxX are the starting and
ending index numbers of the columns. The values minY and maxY are the starting and

12



ending index numbers of the rows.

The quantity, avgR, is the radius of the averaging circle in Km. It is used to find all radial
vector grid points that are 'near' each undeleted total vector grid point. The meaning of
'near' is the value you specify. The quantity maxV is the maximum expected total vector
speed in cm/s; t will be used to remove bad vectors

13



3.8 Coverage display...

Loverage

Two Site Coverage Display

This display applies to the site-to-site
pair (See X-axis in "Vector Grid'). It uses

Max Km in 'Sites.../More...' for range info.

Multi-5ite Coverage Display

p v =
LS piay ¥

(Requires grid + delete shadowed)

Due to limits on the size of 'regions’,
this display may not be printable. It
uses #Range Cells, Dist to 1st and RC
spacing in 'Sites.../Grid..." for range info.

Stability Criterion

erf, Error factor: (1-10
or
era, Error angle: (5-90)

When combining two radials into a
total vector the angle between them
must be >= era and <= (180 - era).

| Enable the coverage display

( Cancel ) | Draw | | DK |

The coverage display shows the area of
the ocean over which the current site
configuration can calculate total vectors.
There are two methods employed in
calculating the coverage area. These
methods correspond to the top two
sections of this dialog box shown to the
left.

The bottom section of the dialog box
applies to both methods. This section
allows you to define the stability criterion
and to enable/disable the coverage
display. This last item allows you to turn
the coverage display on and off without
changing the settings. It is also used when
you want to save a coverage display in
place of the black & white map within the
SeaDisplay_Site_XXXXfile. The dialog
box and a coverage map are shown on the
next page.

The Two-Site Coverage Display

The Two-Site Coverage Display method
assumes ideal coverage based on the
maximum range of the individual sites;
however, landmasses and obstructions are
not excluded from the coverage display.
The ideal coverage is computed and drawn
first and then the land areas are drawn on
top of that.

The coverage area and stability region are
each computed as the intersection of two
circles. The portions of the map that lie
outside of these intersections are
represented internally and colored with
Macintosh QuickDraw 'polygons'.

14



Example Coverage Display
e 0 SeaDisplay_Site_SFBY
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The Multi-Site Coverage Display

The Multi-Site Coverage Display method overcomes some of the limitations of the first
method by enforcing bearing limits and detecting shadow zones (range limits). This
method can be applied to the two sites that define the baseline, or to all two site pairs or
to all three site pairs. However, the price paid for these additional abilities is that the
method relies on the Macintosh QuickDraw 'region' operations to compute intersections
and unions of various segments of the coverage area. And the Macintosh Operating
System (Mac OS) imposes a 64KB limit on the size of any one region. This is no
problem for maps displayed on the screen. But, the limit will be exceeded if you try to
write JPEG formatted files at high resolutions of 300 or 600 dots per inch.

Another restriction of the second method is if you wish to enforce range limits then you
must define radial grids for the SeaSonde sites and delete the shadowed grid points.
As in the first method of coverage display, you can exclude the regions of instability in
this method. And, if you wish to see just the stable, you can check the Show stable
regions only box.
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4.0 Creating a SeaDisplay Site file
SeaDisplay and RadialDisplay requires a site definition file that has a name in the form

SeaDisplay Site XXXX, where XXXX is a four-character name for your SeaSonde site
installation. This section describes how to create this SeaDisplay site file.

4.1 Starting Out

Format of the SeaDisplay Site file

The site definition file is a resource file containing three types of resources: picture,
string and a private type named MySU. The picture type resource contains three
pictures of the coastal map. One picture is in full color and is used for the map
displayed on the computer monitor. One picture is in black and white for monochrome
monitors, but may be replaced with a coverage map. The third picture is geared toward
printing the map, therefore the sea color is set to white.

SeaDisplay uses the parameters embedded in the MySU resource. The strings can be
viewed with any application that displays the contents of the resource fork of a file, such
as ResEdit.

The MySU type resource is a copy of the site and coastal parameters that application
SeaDisplaySetup used to create the area map. These parameters are used in
application SeaDisplay in a variety of ways from the creation of the vector grid to the
proper location of latitude and longitude points of the display screen.

Files and Folders

Before you start, you need to have the necessary files and folders in place. In addition
to the application SeaDisplaySetup, you will need the coastline database files. These
files are usually kept in the subfolder MapDataBase within the same folder as the
application SeaDisplaySetup. The coastline database WVS250K.DAT is the file most
used, but you might like to have the others on hand if you want to work with different
resolutions or create vector grids. For more information on the types of databases
available, click the “?’ next to Data base under the Area sub-section in the Map drop-
down menu.

4.2 Making the Initial Map

There are various ways that this step can be done; one will be discussed here. You
need to know the approximate latitude and longitude of a point along the coastline of
your proposed installation. With this information you can create the initial map by first
launching the application SeaDisplay Setup. Then, select New from the File menu to
get the default Monterey Bay coastline. Then select Area from the Northwest and
Southeast corners of the area. Then enter your approximate longitude and latitude for

16



the Northwest and Southeast corners of the area. Then check the box Maximum-sized
window and a coastline map will be drawn.

Now you can use key commands to adjust the size of the displayed coastal area and
the map window.

<arrow> will shift the coastline left, right, up or down

<shift><arrow> will expand and contract the displayed coastal area
<control><arrow> will expand and contract the window

<option><arrow> will zoom-in and zoom-out

YV V VYV V

Adding SeaSonde Sites

Turn on the Show location option under the Options menu. Select the Sites... dialog
from the Map menu. Now add your first site by clicking the Add button and entering a
site name. Then you can enter the longitude and latitude of the site on the map.

Add the second site in a similar fashion. For both sites, supply an approximate
maximum range by clicking the More button of the Sites dialog and then entering the
value into the Max Km edit box. These values can be used to draw a two-site coverage
display, which can be helpful while you are adjusting the size of the map window.

Adding Map Annotations

It is possible to add map annotations such as a title, a N/S arrow, a legend, etc. from the
Map menu. For each item, you must define and position the annotation. Once you
have positioned your annotation(s), click OK to have it saved. Here is a sample map for
the SF Bay area with many added map annotations.

17
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4.3 Saving the site definition file

To save the file, select the item Save as... from the File menu. Then, select your
desired options and give the file a name in the form of SeaDisplay_Site_ XXXX where
XXXX is the four characters you have chosen to represent the SeaSonde installation of
this area.

Note:

Before saving the site definition file, you should select the item Vector grid...,
under the Map menu, and click the X-axis definition. Click the Show the x-axis
and origin button to view and check your x-axis (uncheck this box to make this
axis invisible on your map).

In addition, it is a good idea to view the coverage of your sites before saving; this
is done by selecting Coverage display from the Map menu. At the bottom of this
dialog box, click the Enable the coverage display. You can adjust what coverage
you prefer by selecting various radio buttons and inputting various Stability
Criterion. This feature is discussed in greater detail in the section Map Menu:
Detailed.
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The first dialog box that appears after selecting a name for your site file is shown below:

' ) 7 Site File Options
Select parameter format.

_ Older format (no grid,...)
f® Latest parameter format

Select desired extra files.

Three maps are created:

full color, black & white, and
printer (sea color is white). You
may replace the B&EW map with a
coverage map in full color.

'21 Replace B&W with coverage

[ Cancel | - oK

Typically, the default parameters
shown in the figure on the left are
used; i.e. the Latest parameter
format and Installable grid files with
Replace B&W with coverage.
However, if you’d like to change
these settings, the other options
are listed below.

The radio buttons Older format (no
grid,) and Latest parameter format
allow you to select an older file
format in case you need to be
compatible with an older version of
SeaDisplay. The resulting format
will not contain grid information,
markers, color sites or other
additional features.

The check boxes allow you to
create extra files. Checking the V3
coastline (gshhs_XXXX) box will
cause a reduced closed polygon
file to be written, provided that your
map was created with a closed
polygon database. This special file
is a set of closed polygons that
covers only the region of your map.

Checking the Grid file box will cause a folder to be created and all of the files necessary
to use SeaDisplay will be included in that folder. Checking the Installable grid files box

will cause a folder to be created and all of the grid files required by the Combine
software will be included in that folder. The Original format check box allows you to
specify the older format for those files.
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5.0 Creating a Vector Grid

You may want to create a vector grid in SeaDisplaySetup. This is not necessary if you
are using your site map only in RadialDisplay. In addition, grid files are generally
created in SeaDisplay for use in SeaDisplay. However, SeaDisplaySetup has the
capabilities to create a vector grid. This following section discusses how to create a
vector grid in SeaDisplaySetup.

To create a total vector grid and its associated grid files you will need these three items:
> A previously created site definition file
> The range cell specifications for each SeaSonde site
> A closed polygon coastline data base file

The site definition file is a file named SeaDisplay Site XXXX, where XXXX is the 4-
character installation name. Section 4.0 Creating a SeaDisplay Site file describes how
to create this site file.

The range cell specifications for each site are the number of range cells, the distance to
the first range cell in Km, the distance between range cells in Km, the range cell
reference angle (almost always 90 degrees), and the angular resolution (usually 5
degrees). All of these values except the angular resolution can be supplied by the file
named Header.txt; this file is found at each remote site in the RadialConfigs folder.

The closed polygon coastline data base file that is generally used for the purpose of

creating vector grids is either gshhs_h.b (high resolution) or gshhs_f.b (full resolution).
Follow the steps below to create the vector grid and associated grid files.

5.1 Create a reduced closed polygon coastline file

In order to create a grid file in SeaDisplaySetup, you must first select Area from the Map
drop-down menu. Next, select the Data Base drop-down menu, and highlight any map
data base beginning with gshhs. These coastline data bases contain more than
180,000 closed polygons arranged in size of area from largest to smallest. The largest
area is the closed polygon representing the combination of Africa, Europe and Asia.
This polygon contains more than 1.4 million points.

Application SeaDisplaySetup must sort through all 180,000+ polygons to find all that
intersect your desired coastline area. This can take up to 4 minutes on a G4 Macintosh
computer. This polygon search is triggered every time you change the coastline area or
whenever you switch to a closed polygon database.

After you have switched to the gshhs_f.b database file and let the application finish its
search and draw a new map (the notation 'V3' will appear in the bottom left corner), you
can save a short form of a closed polygon data base file that has only those polygons
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used to draw the new map. Do this by selecting Save as... from the File menu and
checking the box V3 coastline (gshhs_xxxx) before clicking the OK button to save the
site definition file.

A file named gshhs_XXXX, where XXXX is the same 4 characters in your site definition

file name, will be created in the same folder as the new site definition file. And, the next
time you open that site definition file the gshhs_XXXX file will be used to draw the map.

5.2 Create the radial grid for each site

After you have switched to a closed polygon data base file (a file named

gshhs_?.b), there will be the notation V3 in the lower left corner of the map window.
Now select the Vector grid... item under the Map menu and check the Enable grid
options box. If you had some grid display options checked prior to this it may trigger the
application to search for grid point containment.

Next open the Sites... dialog (select Sites... under the Map menu) and for each site
supply the range cell specifications by clicking the Grid... button and entering the values
for # Range Cells, Dist to 1st RC, RC spacing, and Ref angle. Or, if you have the
Header.txt file available, check the box Use the site's Header file, and use the Open...
to open the file.

Then, if you want to see the radial grid, you can check the box Draw this radial grid and
select amongst the options below it (selecting only one option is recommended so you
can see the effect of each option on the map). Then click the OK button. After you have
supplied the range cell specifications for each site, proceed to the next step.

5.3 Create the total vector grid

In the Vector grid... dialog, define the x-axis of the grid by clicking the Baseline (x-
axis)... button and selecting the sites that will be the end points of the x-axis.

Then, define the total vector grid by clicking the Grid definition... button and supply the
grid spacing in Km, the minimum and maximum indexes of the columns and rows and
the radius of the averaging circle in Km. Then select your grid display options by
clicking the Grid options... button and checking the desired options. First, check the
boxes Draw the grid and Retain all grid points so you can see the entire grid that was
defined. You may want to adjust the column and row indexes, or the grid spacing.

After you have finished adjusting the grid, leave all of the grid options that you want
turned on. But, turn off all of the Draw this radial grid check boxes in the

Sites... dialog (Grid... button) and turn off the Draw the grid check box in the Vector
grid... dialog (Grid options... button). Close all open dialog boxes by clicking their OK
buttons and proceed to the next step.
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5.4 Create and save the grid files

There are two sets of grid files that application SeaDisplaySetup can create after you
have created the radial and total vector grids that you want. The first set of grid files (the
full set) is the same set of files that application SeaDisplay creates and saves in its Grid
files subfolder. Thus, if you want to further hand edit the grid, you can replace the files in
the subfolder Grid_ files with this set of files and use application SeaDisplay to edit the
grid.

The second set of grid files is the same set that application SeaDisplay creates for use
with the combining software. Select Save as... from the File menu and check the box
Grid files if you want the first set of grid files to be created and saved. Check the box
Installable grid files if you want the second set to be created and saved. Part of the first
set of files are the Header.txt files and the parameter files for each of the SeaSonde
sites. If you had copies of these files and opened them when you were defining the
radial grids then these files will be copied as part of the first set. But, if you merely
supplied the range cell specification without the Header.txt file, then SeaDisplaySetup
will create a short version of the Header.txt files and post a warning message that they
cannot be used for any other purpose. The first set of grid files (the full set) is placed in
a folder named Grid_files _XXXX', and the second set of files is placed in a folder
named Install files XXXX, where

XXXX is the 4-character name from the SeaDisplay Site XXXX file.
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6.0 Other Items

There are a few other features within SeaDisplay Setup that should be mentioned,
including resizing windows, special key commands, and database references. The
following section gives information on these topics.

6.1 Resizing Windows

There is no “grow box” in the bottom right corner of the map window. Instead, the
cursor arrow changes to a double arrow when it is in the grow box region (bottom right
corner of the map window). You can then click and drag to resize the window. When
you release the mouse button, the window will be resized to the closest size that
maintains the aspect ratio of the original site map.

When the window is closed, it will remember its last location and size. Then when it is
reopened, it will reappear in its last location and size.

Note: Maps look best at their default size because there is no distortion due to
expanding or shrinking of the annotation and coastlines. If a map’s default size is
small, then expanding the map to a large size will cause the lines that draw the
coastlines to thicken. The aspect ratio is maintained so that relative distances
are correct. The plots will always look best when the map is its default (original)
size.

6.2 Key Commands

Special key combinations can be used in the following situations:

» <arrow> means to shift the window in the direction of the arrow key

» <shifts<arrow> means to expand or contract the coastline area and increase or
decrease the window size accordingly

» <control><arrow> means to expand or contract the window while maintaining the
same coastline area

» <option<arrow> means to zoom-in or zoom-out while maintaining the window
size

While using the GSHHS coastline database the access times are too great to allow
panning, expanding, contracting and zooming of the displayed coastal area. Only the
size of the map window can be adjusted, i.e. only the <control><arrow> key
combination works while using the GSHHS database files.

Drag and Drop
These features are limited to opening either the site definition files or the MATLAB®
compatible text and JPEG files previously created by this application.
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6.3 Identify land and Swap colors

When you open a new map window (select New from the File menu) you get a window
with the outline of the coastline along Monterey Bay, California on a light blue
background. The default coastline database (WVS) does not distinguish which part of
the map window is sea and which part is land. That database only records where the
coastline is located. The application, however, will attempt to determine which is which
and color in the land portion when you select Identify land from the Options menu.

Sometimes the Identify land option fails and colors the sea as if it were the land. This
can occur because the coastline points retrieved from the database consist only of
coastline segments that fall within your defined coastal area; the application assumes
the largest polygon will represent the sea. If the largest polygon is not the sea then the
colors will be reversed. In this case select Swap colors from the Options menu to
correct the problem.

6.4 Coastline Databases

The coastline database used in this application consists of three groups of data files:
> World Vector Shoreline files
> World Data Bank Il files
> Global Self-consistent Hierarchical High-resolution Shoreline files

There is much information on the data bases used to create site maps in
SeaDisplaySetup, however they are not contained in this manual. If you would like
more information on the coastline database, you can search the Internet for
“NOAA/NGDC-Global Relief Data”.
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